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Figure 18-11:
Choose
Install New
System
Folder for an
automatic
Clean Install.
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Figure 18-12:
The button
changes
from Easy
Install to
Clean Install.
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When the Installer is through, you'll have a brand spanking new System Folder
on your hard disk. Your old System Folder has been renamed Previous System
Folder. Nothing has been removed from it.

The folder called Previous System Folder contains all your old third-party
extensions, control panels, and fonts. Because it's possible, even likely, that one
of these items contributed to your problem, [ recommend that you reinstall
them one item at a time. In other words, move one extension or control panel
from Previous System Folder onto the new System Folder's icon. Then restart
and work for a while to see if any problems occur before reinstalling another.

It's a good idea to trash the System and Finder in the Previous System Folder as
soon as possible after performing the Clean Install.

It's simply a bad idea to have two System Folders on one hard disk, and as long
as Previous System Folder has a System and a Finder in it, your Mac could
confuse Previous System Folder with the real System Folder, and that confusion
could cause you major heartache.

So delete the old System and Finder files, the ones in the Previous System
Folder, now. Just in case. Thanks.
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Figure 18-13:
This Mac is
ready to
perform a
Clean Install
the old-
fashioned
way.
[eos—— = 5

Don't forget that the System Folder is smart. If you drag a control panel or
extension onto its icon (but nof into its open window), it will put the file in the
proper folder for you.

The old and much harder way to perform a Clean Install

There is no reason to ever do a Clean Install the old-fashioned way anymore. It's
presented here as an historical oddity, to show you the way things used to be.

Thanks, Apple, for the Clean Install option in the Installer. It makes things so
much easier. (But why the obscure Command-Shift-K keyboard shortcut?
Shouldn’t it be in the pop-up menu like the Custom Install option?)

1. Drag your System and Finder files to the Trash.

2. Rename your System Folder “OldSys.”

3. Restart your Mac (see Figure 18-13). When the flashing question mark
appears, insert Install Disk 1.

4, Perform an Easy Install on your hard disk as detailed in the section of
Chapter 1 called “Anyone Can Install System 7.5.”

@ File Edit Diew Label
Clean Up Window

Empty Trash...
Eject Disk HE
Erase Disk...
Shut Down
Lisa's HD B Trash
4items 63.7MBindisk S0SMBJ 2 items
Name sizff (1  Mame
b 03 Apple Extras D Finder

(] System

When the Installer is through, you'll have a brand spanking new System Folder
on your hard disk.

Don't bother trying to empty the Trash after Step 1. It won’t empty for obvious
reasons. Don’t sweat it, as you'll be able to empty it after you perform the Clean
Install.
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Appendix

Macintosh System 7.5 Update 2.0
and Macintosh System 7.5
Revision 2.0

A Word from the Author

This book was written about 15 months ago when System 7.5 was brand new.
Since that time Apple has released several major and minor updates to System
7.5 and while it would be nice if we could revise the entire book each time
Apple releases an update, it would be a logistical nightmare and is just not
going to happen. The good news is that even with the updates and revisions, at
least 98.6 percent of the book is still absolutely accurate.

Since we can't revise the book every time Apple revises the System software, |
instead offer you this appendix, which contains important information about
the latest, greatest updates, what they are, where to find them, and who should
install them,

What Version Do | Have Anyway?

To determine what version of System software vour Mac is currently running,
follow the instructions in Chapter 4 in the section, “About This Macintosh
(Yours).” If that's too much trouble, choose About this Macintosh under the
Apple menu in the Finder.
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What They Are, What They Do, and Why
Vou Should Install Them

Macintosh System 7.5 Update 2.0 is a 14-floppy-disk set (also available on
CD-ROM) of bug-fixes, improvements, enhancements, and more. Once installed,
your System software version becomes “System 7.5.3.” If you're running any
version but 7.5.3, you should absolutely perform this step. You must complete
this update before you can even consider installing Revision 2.0.

Macintosh System 7.5 Revision 2.0 is a separate two-floppy-disk update with
even more bug-fixes and enhancements. Not all Macs require it (see “What
System 7.5 Revision 2.0 Is™). Once installed, your System software version
becomes “System 7.5.3 Updated to Revision 2.”

After you've installed one or both of these updates, your Mac will run faster,
crash less, and be able to leap tall buildings in a single bound.

Note: It's entirely possible that by the time you read this there will be an even
more current version of System 7.5 available. If so, | recommend that you
update to that version as well. Ask about it when you call Apple or download
the updates from an on-line service (see “Where to Get It™).

Where to Get It

The revisions are available on most on-line services, including America Online,
CompuServe, and Applelink. Customers in the United States may also order the
updates on floppy disk or CD-ROM for a modest fee (under $20) by calling
1-800-293-6617. In Canada, customers may order the update by calling
1-800-361-6075.

How to Install It

*gﬂﬂsﬂ

Insert Disk 1 (or the CD-ROM) and double-click the Installer. From here it's just
like installing System 7.5 (see Chapter 1). Hint: Select the Easy Install option
unless you have some compelling reason to choose a Custom Install. Another
Hint: You probably don't.

After you install Macintosh System 7.5 Update 2.0, your Mac (or clone) will be
running System 7.5.3. If you also install the separate Macintosh System 7.5
Revision 2.0 (not everyone needs it; see the following section), your System
software version will be System 7.5.3 Updated to Revision 2. Sharing informa-
tion like this will almost certainly make you the life of any party.
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What System 7.5 Update 2.0 Is

System 7.5 Update 2.0 provides the enhancements introduced in System 7.5
Update 1.0, plus many more. If you're running any version of 7.5, you should
install it.

This update provides newer versions of many components (including any
components that you disabled using the Extensions Manager) that it finds on
the disk it is updating.

A file called “System 7.5 Update” replaces the enabler on all computers capable
of running System software versions 7.5 and/or 7.5.1. Computers that did not
previously need an enabler to work with System software versions 7.5 and 7.5.1
still need the System 7.5 Update file since it contains most of the fixes delivered
in this update.

A file called “System 7.5.2 Update” replaces the enabler file on all computers
capable of running system software version 7.5.2.

This update includes all of the fixes included with the previously released 7.5.2
Printing Update, the PowerBook 5300 System Software Update, and the
PowerBook 2300c Update. You do not need these updates if you install System
7.5 Update 2.0. If you previously installed any of these updates, you should still
install System 7.5 Update 2.0 because it contains additional fixes.

Specific changes include more robust versions of many components such as
SimpleText, Launcher, Open Transport, MacTCP, Apple Modem Tool,
Macintosh Easy Open, and others.

What System 7.5 Revision 2.0 Is

Revision 2 is not meant for everyone, but if it's recommended for you (see the
next paragraph), you will benefit from a more stable system after you install it.

Macintosh systems that benefit from System 7.5.3 Revision 2 include all
PowerBook systems using Connectix RAMDoubler; all PowerBook 5300 and
PowerBook Duo 2300 systems; all PowerBook 200 or 500 Series systems that
have been upgraded with the Macintosh PowerBook Processor Card Upgrade
Kit with PowerPC (or upgraded with similar third-party products); and all
Macintosh 7200, 7500, 7600, 8500, and 9500 systems. In addition, to benefit from
Revision 2, these systems must be running System 7.5.3, or specific versions of
System 7.5.2 for PowerBook products.
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System 7.5.3 Revision 2 provides numerous system reliability and stability
improvements. If your Mac model is listed in the preceding paragraph, you
should definitely acquire and install it.

The Bottom Line

Everyone should install System 7.5 Update 2.0, and if you have one of the Mac
models [ just listed, you should also install System 7.5 Revision 2.0.

<MBER Don’t forget, the Installer is smart and replaces your old System files with new

g ones, even ones that have been disabled by Extensions Manager. So you don'’t
have to worry about, say, deleting your old WindowShade control panel before
running the Installer. The Installer will do all your housekeeping for you.

If you have questions about new System software components (such as Open
Transport, Desktop Printing, and so on) that aren't covered in the body of the
book, I urge you to check with either Apple (1-800-SOS-APPL), Power Computing
(1-800-708-6227), or your local dealer.
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32-bit addressing, 243-244

68040 chip, enabling/disabling
caches, 274-275

e/ e

A/ROSE, 361
About Help command, 83
About This Macintosh
command, 90-93
actions, redoing/undoing, 68
active window, 37
printing picture, 66
ADB (Apple Desktop Bus), 13
Add Alias to Apple Menu
script, 312
advanced techniques,
261-268
After Dark, 326
alert sound, selecting,
303-304
aliases, 62, 166-173
adding quickly to Apple
menu, 171
Apple Menu Items folder, 172,
312
finding names and, making,
313-314
hard disk in Apple menu, 171
icons on Desktop,
167-171
memory requirements, 168
original items (parents), 314
remote folders, 226
temporary, 168-169
Anti-Virus, 24
Apple Backup program, 23
Apple CD-ROM extension, 337
Apple Chancery, 101
Apple Guide extension, 337
Apple HD SC Setup, 17, 377
Apple laser printer, configur-
ing, 367
Apple LocalTalk Locking
Connector Kits, 211
Apple Locking Cable Kits, 211
Apple Menu Items Folder alias,
173
Apple menu, 63, 89-113, 256

L]

Index

2 0600 deesE e
adding aliases quickly, 171
Automated Tasks folder, 109
Control Panels folder, 107
customizing, 109-111,

261-266
dividers, 263
hard disk alias trick, 171
hierarchical submenus,
105-107
icon-less dividers,
264-266
items appearing at top, 261
Mail & Catalogs folder,
107-108
multiple spaces before name,
262
new features, 145
putting desk accessories
(DAs) in folder,
109-111
Recent Applications folder,
108
Recent Documents folder, 108
Recent Servers folder, 108
selecting programs, 111
special characters and
sorting items, 263
triangles on folders, 106
tricks, 171-173
Apple Menu Items folder, 109,
110, 349-350
aliases, 171-172, 312
Apple Menu Options control
panel, 106, 145, 269-271,
329
Remember recently used
items check box, 108
Apple MenuroAbout The
Finder, 93
Apple menurAbout This
Macintosh, 233, 235
Apple menuyAutomated
Tasks=>Create Alias
Folder, 314
Apple menusAutomated
Tasks=>Find Original, 314
Apple menuc>Automated
Tasks>Sync Folders, 316
Apple menu=>Chooser, 180,

e P e0CEPS

e POO QO
207, 212, 224, 226
Apple menuriControl Panels,
106
Apple menuc>Control
PanelstExtensions
Manager, 283
Apple menur:Control
Panelst>Memory, 237, 239
Apple menur>Control
Panels=>Sharing Setup,
213, 229
Apple menu=>Control
PanelstvUsers & Groups,
215, 217
Apple Open Collaboration
Environment (AOCE), 154
Apple Photo Access exten-
sion, 338
AppleCD Audio Player, 95
AppleGuide documents, 345
AppleMail, 155
Apple’s technical support
line, 373
AppleScript, 309-310
attachable programs, 317
Automated Tasks folder,
312-316
levels of program support,
317
macros, 140
new features, 140-142
recordable programs, 317
saving scripts, 320-321
Script Editor, 311, 312
scriptable programs, 317
Scripting Additions folder,
311
scripts, 109
“Watch Me" mode, 140
where parts are installed,
311-318
writing scripts, 318-320
AppleScript extension, 311,
3338
AppleScript Guide, 311-312
AppleScript-enabled programs,
316-317
AppleShare extension, 344
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AppleShare icon, 224
AppleTalk, 212, 224
active or non-active during

printing, 183-184

AppleTalk printer, 182

AppleTalk Service extension,
345

application icons, 27

Application menu, 86-87

applications, 27. See also
programs
how many to track, 269-271
memory size, 236
memory usage, 235-236
tracking last used, 108
Applications folder, 45-46, 163,
166
ATM (Adobe Type Manager),
QuickDraw GX, 271-272
ATM GX control panel, 271-272,
329
attachable programs, 317
Audio CD Access extension,
95, 338
author's real system, 112-113
AutoDoubler, 323
Automated Tasks folder, 109,
312-316
Automated Tasks submenu, 256
automatic power off, 147
AutoRemounter control panel,
272-273

el e
background printing, 200
backing up, 21-24
labeling floppy disks, 23
mirror image of hard disk, 325
Balloon Help, 83-84
BBS (bulletin board service),
getting viruses from, 24
bit depth, 257
bitmapped pictures
printing clearly, 191
booting, 17-18
Brightness control panel, 273-
274
bus, 13
ADB (Apple Desktop Bus), 13
SCSl, 13
Business Card Templates
extension, 346
by Name command, 266

oo

cables, plugging in, 13
Cache Switch control panel,
274-275, 329
Calculator, 96
cartridges, ejecting, 314
Catalog icons, 32
Catalogs extension, 338
CD-ROM drive
Apple, 20
installation, 20
listening to music, 304
non-Apple, 20
CDs
extra goodies on the CD,
21-22
playing, 95
Change dialog box, 299
check boxes, 56
Chooser, 97, 212
AppleTalk Active/Inactive
radio buttons, 183-184
PDD Maker GX icon, 207
printer drivers, 181
printer icon, 181
Chooser desk accessory (DA),
180-184
Desktop Printers, 202
Chooser Extension, 181, 344-
345
Clean Install, 386-389
Clean Up command, 79-81
Clear command, 70
Clipboard, 67, 350
aliases as Apple menu
dividers, 263
copying item to, 70
displaying contents,
69-70
pasting items from, 70
putting alias in Apple menu,
69
Clipping extension, 338
Clippings file, 144
close box, 38
Close Finder Windows
script, 313
Close View, 362
Close Window command, 58
CloseView control panel, 276
coachmarks, 138
color
consistency between screen
and output, 277

highlight, 277
time-saving tips, 254-259
windows considerations,
257-258
Color control panel, 257, 277,
329-330
Easter egg, 277
Color Picker extension, 338
ColorSync extension, 339
ColorSync Profiles, 352
ColorSync System Profile
control panel, 277, 330
commands
About Help, 83
About This Macintosh, 90-93
Apple MenusAbout The
Finder, 93
Apple menur>About This
Macintosh, 233-235
by Name, 266
by Small Icon, 72
Clean Up, 79-81
Clear, 70
Close Window, 58
Copy, 70
Cut, 69
Duplicate, 61
Editr>Clear, 103
Edit=>Copy, 60, 98, 103, 265
Edit=>Cut, 103
Edit=>Paste, 60, 98, 103, 265
Edit<>Preferences, 105, 267
Eject Disk, 81
ellipses (...) after, 54
Empty Trash, 81
Erase Disk, 81
Extension Setup, 205
Filee>Close, 104, 212
Filec>Close All, 318
Files>Close Window, 38
FilesDuplicate, 48
FilesrGet Info, 92, 98, 236, 265,
314
FilecoMake Alias, 111, 167, 171
Filew:New Folder, 45, 110, 313,
318
Files>New Group, 217
Filew’New User, 215
FilervOpen, 63, 110, 204
Filec»Open Enclosing Folder,
64
Filec>Print, 192
Filer>Put Away, 52, 227
FilerSave, 118



Filer>Sharing, 219, 230

Find, 63-64

Find Again, 65

Find File, 63

Get Info, 59-61, 259

Helpc>Show Balloons, 91

Hide Others, 87

Hold Print Request, 204

Macintosh Guide, 84-86, 138

Make Alias, 62

New Folder, 57

New Group, 215

New User, 215

Open, 58

Page Setup, 65, 184

Paste, 70 :

PowerTalk Guide, 86

Print, 58, 66

Print Desktop, 66

Print Setup, 184

Print Window, 66

Printing=>PDD Maker Setup,
207

Put Away, 62-63

Restart, 81-82

Resume on Page, 204

Resume on Page One, 204

resuming with specific page
number, 204

Save, 320

Save As, 126-129, 320

Select All, 71

Set Default Printer, 204

Set Print Time, 204

Sharing, 61

Show All, 87

Show Balloons, 83-84

Show Clipboard, 69-70

Shut Down, 82

Special<vEmpty Trash, 31, 59,
246

Special->Erase Disk, 246

Special->Restart, 381

Special=>Shut Down, 11, 227

Start Print Queue, 204

Stop Print Queue, 204

Undo, 68

Unlock Key Chain, 81

View by Date, 73-74

View by Icon, 71-72

View by Kind, 73

View by Label, 73

View by Name, 72

View by Size, 72

Viewtby Name, 109
Viewr> by Size, 110
commercial backup software,
22-23
computer viruses, 24
Conflict Catcher, 147
Conflict Catcher II, 283, 385
Connect dialog box, 224, 226
hard disk alias, 227
control panel icons, 27
control panels, 137, 269-308,
328
access to, 107
Apple Menu Options, 106, 145,
269-271, 329
ATM GX, 271-272, 329
AutoRemounter, 272-273
Brightness, 273-274
by disk space used, 335-336
by RAM used, 335
Cache Switch, 274-275, 329
changing loading order, 384-
386
CloseView, 276
Color, 277, 329
ColorSync System Profile, 277,
330
Control Strip, 277-278
CPU Energy Saver, 275-276
Date & Time, 278-280, 330
definition of, 107
Desktop Patterns, 281, 330
disabling, 327-328
Easy Access, 281-282
Extensions Manager, 282-
284, 330
File Sharing Monitor, 228-
229, 284, 330
General Controls,
285-287, 331
Keyboard, 287-288, 331
Labels, 288-289, 331
Launcher, 160-162, 289, 331
Macintosh Easy Open Setup,
290-291, 332
MacTCP, 149, 292
managing, 282-284
Map, 292, 332
Memory, 237-248, 293, 332
Monitors, 293-295, 332
Mouse, 296, 332
Network, 296-297, 333
Numbers, 297, 333
PC Exchange, 298-299, 333

Index 39 7

PowerBook, 299-300
PowerBook Setup,
301-302
PowerTalk Setup, 302, 333
recalcitrant, 384-386
resolving conflicts,
382-384
running from floppy disk, 326
Sharing Setup, 302, 333
Sharing Setup control panel,
213-215
Sound, 303-304, 334
Startup Disk, 304, 334
Text, 305, 334
Users & Groups, 305, 334
Views, 306-307, 334
what are they, 326-328
WindowShade, 40, 146,
307-308, 335
Control Panels folder, 107
Control Strip, 150
AppleTalk Switch, 151
Battery Monitor, 151
File Sharing, 151
Hard Disk Spin Down, 151
Power Settings, 151
showing/hiding, 277-278
Sleep Now, 151
Sound Volume, 151
Video Mirroring, 151
Control Strip control panel,
277-278
Copy command, 70
CPU Energy Saver control
panel, 275-276
crashing at startup, 381-389
clean System reinstallation,
386-389
recalcitrant extensions/
control panels, 384-386
resolving extension/control
panel conflicts, 382-384
restarting without extensions/
control panels, 381
Create Alias Folder script,
313-314
cursor, numeric keypad
control, 281-282
customization, 142-147
Cut command, 69

o)) e

data recovery services,
DriveSavers, 22
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date formats, 279-280
Date & Time control panel,
278-280, 330
Clock Options button, 280
Daylight Savings Time check
box, 280
Set Time Zone button, 280
setting date and time, 279
Time and date formats, 279-
280
Date Formats dialog box, 279
default button, 19
Default Document folder, 145-
146
desk accessories (DAs), 89,
94-105
AppleCD Audio Player, 95
Calculator, 96
Chooser, 97, 180-184
Find File, 97
Jigsaw Puzzle, 98-99
Key Caps, 99-101
Key Chain, 101
Note Pad, 101-102
putting in folder, 109-111
Scrapbook, 102-103
Shut Down, 105
Sticky Memos, 104-105
vs. programs, 350
Desk Accessories folder, 110-
111
Desktop, 14, 25-52
as active folder, 123
Glenn Brown example, 175
Guy Kawasaki example, 177-
178
icons, 25-32,51, 167-171
Loftus E. Becker Jr. example,
174-175
patterns, 281
printing picture, 66
rebuilding, 374-375
Rich Wolfson example, 175
Robin Williams example, 174
Robyn Ray example, 177
saving documents to, 168
saving files to, 123
saving items to, 120
selecting icons, 12, 71
Steven Bobker example, 174
straightening up, 52
temporary aliases, 168-169
windows, 33-40
Desktop DB file, 374
Desktop DF file, 374
Desktop Patterns control panel,

281, 330
Desktop Printer icon, 32
Desktop Printers, 184, 201-205
automatically selecting, 204
definition of, 201-202
PDD (portable digital
document) format, 207
Print dialog box, 205
Printing menu, 203-204
viewing print queue, 203
why use them, 202-206
Desktops, examples of famous
Macintosh users, 173-178
devices, 210
dialog boxes, 54-56
Digital Active Termination,
379
Disinfectant, 24
Disk Cache, 238-239
rule-of-thumb, 240
setting, 239-241
Disk First Aid, 17, 376-377
Disk Tools disk, 17, 372, 373
Apple HD SC Setup, 377
Disk First Aid program, 376
DiskFit Direct, 23
DiskFit Pro, 23
disks
connecting to shared, 223-226
copying between, 48
disconnecting from shared,
227
Disk Tools, 17
ejecting, 314
sharing, 219-220
unsharing, 230
viewing space used and
empty, 307
document icons, 27
documents, 27
canceling save, 124
closing, 129
naming, 121
opening, 128-129
opening with another
program, 290-291
printing, 66
saving, 118-127
saving to Desktop, 168
saving under different name,
126-129
tracking last used, 108
viewing and printing without
program and fonts,
207-208
Documents folder, 45, 163

organizing tips, 163-164
reopening remote, 226
subfolders, 163
unique icon for, 225
Documents on Desktop folder,
145-146
dogcow, 189, 191
DOS
compatibility, 148
reading files, 298-299
double-clicking, 12
icons, 29
Drag and Drop feature, 169-171
DriveSavers, 22
drop folder, 315
Duplicate command, 61

of e

Easter eggs, 93
About The Finder command _
and, 93-106
Color control panel, 277
Easy Access, 359-361
installing, 361
Mouse Keys, 360
Slow Keys, 360
Sticky Keys, 360
Easy Access control panel,
281-282
Edit menu, 66=71
Edit>Clear command, 103
Edit=>Copy command, 60, 98,
103, 265
Edit=>Cut command, 103
Edit<»Paste command, 60, 98,
103, 265
Edit=>Preferences command,
105, 267
Eject All script, 314
Eject Disk command, 81
Empty Trash command, 81
enabling technologies, 137-
138
Energy Star compliant, 275-276
Erase Disk command, 81
EtherTalk, 212
Eudora, 355
Extension Setup command, 205
extensions, 137, 336-346
A/ROSE, 361
Apple CD-ROM, 337
Apple Guide, 337
Apple Photo Access, 338
AppleGuide documents, 345



Index 3 9 9

AppleScript, 338
AppleShare, 344
AppleTalk Service, 345
Audio CD Access, 95, 338
Business Card Templates,
346
by disk space used, 347-349
by RAM used, 346-347
Catalogs, 338
changing loading order, 384-
386
Chooser, 344
Clipping, 338
Color Picker, 338
ColorSync, 339
disabling, 327-328
File Sharing, 340
File System, 340
Find File, 340
Finder Help, 346
Finder Scripting, 340
Foreign File Access, 340
High Sierra File Access, 340
InlineFilter, 341
ISO 9660 File Access, 342
Macintosh Easy Open, 342
Mailbox, 342
managing, 146-147, 282-284
Network, 342
PDD Maker GX, 345
Peirce Print Tools, 185
PowerTalk, 342
PowerTalk Manager, 342
Print Tools, 205
Printer Drivers, 345
Printer Share, 343
PrinterShare GX, 343
Quadra (PowerBook, Power
Macintosh, or Performa)
Monitors, 343
QuickDraw GX, 344
QuickTime, 344
recalcitrant, 384-386
resolving conflicts, 382-384
SCSI Manager 4.3, 344
selecting for printing, 205
system, 337-344
turning off, 233
what are they, 326-328
extensions icons, 28
Extensions Manager,
146-147, 382
Extensions Manager control
panel, 282-284, 330
enabling/disabling exten-

sions/control panels,
327-328

sets, 283

turning off extensions/control
panels, 235, 237

oefe

FIFO (First In First Out), 270
file list box, 119
File menu, 56-66, 126, 215, 259,
320
File Sharing, 61, 97, 209-230
access and privileges, 218-
223
aliases for remote folders, 226
AppleTalk, 224
changing passwords, 229
connecting automatically at
startup, 226
connecting to shared disk or
folder, 223-226
disconnecting from shared
folder or disk, 227
everyone having access, 220
folders or disks, 219-220
getting on your cpu from
remote cpu, 226-227
groups, 217
guests, 218
information about, 284
linking programs, 210
local devices, 210
LocalTalk network, 210-212
make all enclosed folders
like this one option, 222
monitoring, 228-229
networks, 210
New User, 215
no one but yourself, 221
offfon, 316
one person or one group, 221
others only depositing files
and folders, 222
program linking, 214-215
protecting folder, 223
read-only bulletin boards,
222
remote devices, 210
removing users or groups,
218
reopening remote Documents
folder, 226
setting access privileges, 220
turned off on another

machine, 223
turning on, 214-215
unsharing folder or disk, 230
useful settings for access,
220-222
users, 215-217
what it is, 210
what you actually see, 220
File Sharing Activity monitor,
229
File Sharing extension, 340
File Sharing Monitor control
panel, 228-229, 284, 330
File System extensions, 340
FilerClose All command, 318
FilervClose command, 104, 212
Filec>Close Window command,
38
FilecoDuplicate command, 48
Filer>Get Info command, 92, 98,
236, 265, 314
Filer?Make Alias command, 111,
167, 171
FilervNew Folder command, 45,
110, 313, 318
FilecoNew Group command, 217
FilecyNew User command, 215
FilecOpen command, 63, 110,
204
FilervOpen Enclosing Folder
command, 64
Filer»Print command, 192
FilervPut Away command, 52,
227
Filec>Save command, 118
FileroSharing command, 219,
230
files
aliases, 62, 166-173
backups, 128
canceling save, 124
Clippings, 144
closing, 129
deleting, 81
Desktop DB, 374
Desktop DF, 374
finding, 63-64, 97
labeling, 78-79
launching, 289
managing, 159-178
naming, 121
opening, 63, 128-129, 169-178
organizing, 162-166
quick-opener, 166-173
restoring deleted, 324-326
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retrieving deleted, 32
root level, 162-163
saving, 118-129
searching by labels, 78
single-clickable icons that
launch, 160-162
sorting, 266
translators, 58
viewing and printing without
program/fonts, 207-208
Find Again command, 65
Find command, 63-64
searching by labels, 78
Find dialog box, 63-64
Find File command, 63, 97
Find File extension, 340
Find Original from Alias script,
314
Finder, 31, 350
automatically active, 268
better visual cues, 147
closing all open windows, 313
deactivating Calculate folder
sizes, 259
Geneva 9 font, 258
hiding, 145
returning to, 285
selecting fonts, 306
Finder Help extension, 346
Finder icon, 31
Finder Scripting extension,
340
flashing question mark, 16-17
flashing question mark
problems, 372-381
Disk First Aid, 376-377
Disk Tools disk, 373
new hard disk drivers, 377
nothing has worked so far,
380-381
rebuilding desktop, 374-375
reinstalling System software,
380
SCSI problems, 378-380
zapping PRAM, 378
floppy disks
copying System Folder from,
50

ejecting, 63
installation, 18-20
saving file to different, 123
folder icons, 27
folders, 27, 45-50
active in Open and Save
dialog boxes, 287

aliases for remote, 226
Application, 45
comparing and synchronizing
contents, 316
connecting to shared, 223-226
copying items between, 47-48
creation, 45
disconnecting from shared,
227
Document, 45
Documents on Desktop, 145~
146
hierarchical submenus, 105-
109
invisible, 131
listing sizes, 307
moving and copying, 46-48
moving items into, 46
naming, 45
new, 57, 110
opening, 64
path menu, 117
protecting, 286
Save dialog box creation, 124
sharing, 219-220
sorting items within, 266
subdividing, 163-164
subfolders, 46
unsharing, 230
viewing sizes, 315
watching, 315
folders icons, 45
fonts
Apple Chancery, 101
Hoefler, 101
Hoefler Ornaments, 101
information about, 99-101
monospaced, 252
Note Pad, 102
proportional, 252
QuickDraw GX, 101
selecting for Finder, 306
Skia, 101
Tekton, 101
viewing, 99-101
Foreign File Access extension,
340

o7 e

General Controls control panel,
285-287, 331
active folder in Open and
Save dialog boxes, 287
Desktop options, 285

Finder Hiding option, 145
folder protection, 286
insertion point blinking, 286
menu blinking, 286
Show Desktop When In
Background check box,
129
shut down warning, 286
Get Info command, 59-61, 259
Get Info window, 59-61
comments field, 375
customizing icons, 60-61
graphics, storing, 102-103
Graphing Calculator, 96
groups, 217, 220
new, 217
removing, 218
guests, 218

o/ e

hard disks
backing up, 21-24
crashes, 13
icon, 26
installing drivers, 17, 377
making alias, 227
reclaiming space on, 324
repairing, 17
root level, 162-163
hard drives, support for large,
147
hardware, startup failure, 15
help
Macintosh Guide, 138-139
new features, 138-139
shortcuts, 86
step-by-step task guidance,
84-86
Help menu, 83-86
Help=>Show Balloons com-
mand, 91
Hide Others command, 87
Hide/Show Folder Sizes script,
315
High Sierra File Access
extension, 340
Hoefler, 101
Hoefler Ornaments, 101
Hold Print Request command,
204
hot spot, 31
Human Interface Guidelines,
192
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icons, 3, 25-32
aligning, 79-81
alphabetical, 72
AppleShare, 224
application, 27
applications, documents,
folders order, 73
Catalog, 32
comments, 59
control panel, 27
deleting, 30-32
descending size order, 72
Desktop Printer, 32
document, 27
double-clicking, 29
duplicating, 61
extensions, 28
Finder, 31
finding, 63-64
folder, 27, 45
hard disk, 26
information about, 59-61
invisible grid, 306
keyboard shortcuts, 29
large icons, 71-72
locked, 32
Macintosh HD, 26
miscellaneous, 30-32
modification date sorting,
73-74
moving between disks, 48
naming, 30
on Desktop, 167-171
opening, 28-30
putting away, 6263
selecting multiple, 50
selecting next, 36
selecting on Desktop, 12
size and screen updates, 259
small icons, 72
sorting by label, 73
System software, 27
Tray, 32
types, 26-28
viewing, 71-77
viewing on desktop, 118
I'm at command, 81
incremental backups, 23
industry-standard TCP
networks, connecting to,
292
industry-standard TCP/IP,
connecting with, 355-359

INITPicker, 283
InlineFilter extension, 341
Input Trays command, 204
insertion point, blinking, 286
Installer
Custom Install option, 212
restoring deleted files, 325—
326
installing System 7.5, 18-21
CD installation, 20
Clean Install, 386-389
Easy Install option, 18
floppy installation, 18-20
Install Disk 1, 18
Read Me file, 18
internal clock
configuring, 278-280
invisible folders, 131
ISO 9660 File Access extension,
342
items
copying, 70
cutting, 69
deleting, 70
locking, 59
opening, 58
pasting from Clipboard, 70
printing, 58

© ] ©
Jigsaw Puzzle, 98-99

e o

Key Caps, 99-101
Key Chain, 101
keyboard
how it responds to key-
strokes, 287-288
moving among icons, 77
scrolling windows, 36
Keyboard control panel,
287-288, 331
keyboard shortcuts
Command-? (Macintosh
Guide), 84-86, 138
Command-A (Select All), 71
Command-B (Clear), 103
Command-C (Copy), 70, 103
Command-Control-Power On
(Force Restart), 82
Command-D (Desktop), 168
Command-D (Duplicate), 61

Command-E (Open Enclosing
Folder), 64

Command-F (Find), 63-64

Command-G (Find Again), 65

Command- (Get Info), 59-61,
92, 98, 236, 259, 265, 314

Command-M (Make Alias),
62, 111 167, 171

Command-N (New Folder), 45,
57,110, 313, 318

Command-N (New User), 215

Command-O (Open), 29, 58,
63, 110, 204

Command-Option (Rebuild
Desktop), 374

Command-Option-Esc (Force
Quit), 82

Command-Option-P-R (Zap
PRAM), 378

Command-Option-W (Close
All Windows), 39, 313, 318

Command-P (Print), 58, 192

Command-period (Cancel),
124

Command-S (Save), 118, 127

Command-Shift-3 (Screen
Capture), 169

Command-Shift-Clear (Mouse
Keys), 360

Command-Shift-K (Clean
Install), 387

Command-V (Paste), 70, 103,
265

Command-W (Close Window),
58

Command-W (Close), 104, 212

Command-X (Cut), 69, 103

Command-Y (Put Away), 62—
63, 227

Command-Z (Undo), 68

icons, 29

menu items, 29

menus, 54

one key at a time, 359-361

Option-" (Grave Accent (7)),
100

Option-2 (™), 266

Option-8 (=), 263, 266

Option-e (Acute Accent (7)),
100

Option-i (Circumflex (7)), 100

Option-n (Tilde (7)), 100

Option-u (Umlaut (7)), 101

Shift-Tab (Previous Icon), 77

time-saving tips, 251

401
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Label menu, 78-79
labels, 78-79
editing name and color,
288-289
Labels control panel, 79,
288-289, 331
landscape orientation, 186
LaserWriter Utility, 197, 367
Launcher control panel,
160-162, 289, 331
Launcher program, 147, 285
linking programs, 210, 214-215
list views, 72-74
copying or moving items, 76
folder icon triangles, 75-77
icon sizes, 306
switching between, 74-75
local devices, 210
LocalTalk network, 210-213
Apple LocalTalk Locking
Connector Kits, 211
Apple Locking Cable Kits, 211
Macintosh identity, 213
multiple zones, 213
Network control panel, 213
PhoneNet connectors, 211
protocols, 212
Sharing Setup control panel,
213-215
wires and connectors, 212

o/ e

Macintosh

automatically shutting down,
275-276

booting, 17-18

Energy Star compliant, 275-
276

jostling while running, 13

lightning storms, 13

plugging in cables, 13

shutting down, 11, 82, 105

shutting down and restarting,
81-82

startup process, 14-18

turning on, 11

unplugging, 13

what not to do to it, 11-13

what you see after turning
power on, 14

Macintosh Drag and Drop,

143-145, 147

Macintosh Easy Open (MEQ),
148-149, 290
Macintosh Easy Open exten-
sion, 342
Macintosh Easy Open Setup
control panel, 290-291, 332
Macintosh Guide, 138-139
Macintosh Guide command,
84-86, 138
Macintosh HD icon, 26
Macintosh PC Exchange, 148,
148-149
Macintosh Telephony Architec-
ture, 155
macros, 140
MacTCP, 149, 355-360
MacTCP control panel, 149, 292
MacTools, 32, 377
Mail & Catalogs folder, 107-108
Mailbox extension, 342
Make Alias command, 62
Map control panel, 292, 332
pasting picture into Jigsaw
Puzzle, 99
maps, 292
Mavis Beacon Teaches Typing,
252
Maxima, 248
memory
how much is being used, 90—
93
management. See memory
management
problems, 233
Memory control panel, 237-
248, 293, 332
32-bit addressing, 243-244
Disk Cache, 238-241
Easter egg, 243
Modern Memory Manager,
244-245
RAM disk, 245-248
Virtual Memory, 241-243
memory management, 231-
248
Memory control panel, 237-
248
RAM (Random Access
Memory), 231-237
Menu Options control panel
submenus option, 171
menubar clock, 147
menubar clock, configuring,
278-280
menus, 53-87

Apple, 89-113
Application, 86-87
basics, 53-56
Edit, 66-71
ellipses (...) after commands,
54
File, 56-66
Help, 83-86
item blinking, 286
item keyboard shortcuts, 29
keyboard shortcuts, 54
Label, 78-79
selecting items from, 29
Special, 79-82
View, 71-77
MEQ Database, 351
Modern Memory Manager,
244-245
Monitor 1 bit (B&W) script, 315
Monitor 8 bit (256 colors)
script, 315
monitors
adding more colors, 256
adjusting brightness, 273-
274
bit depth, 257
multiple, 294-296
number of colors or grays,
293-295
pixels, 254
redrawing screen, 255
screen updates, 254
settings, 254-257
single, 293
Monitors control panel, 293-
295, 332
maximum supported bit
depth, 315
multiple monitors, 294-296
number of colors displayed,
255
one monitor only, 293
settings, 315
monospaced fonts, 252
Mosaic, 355
mouse, 12, 296
Mouse control panel, 296, 332
Mouse Keys, 360
Move & Rename folder, 131-132
movies, 157
multiple items, selecting, 12
musical chord, 15
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Network control panel, 213,
296-297, 333
Network extension, 342
Network Trash Folder, 131-132
networks, 210
industry-standard TCP/IP,
355-359
LocalTalk, 210-212
Macintosh identity, 213
setting connection, 296-297
Token Ring, 361-362
zones, 213
new features, 135-158
advanced graphics and
printing, 152-154
Apple menu, 145
AppleScript, 140-142
application folder locking, 146
automatic power off, 147
better Finder visual cues, 147
collaborative technologies,
154-157
Default Document folder,
145-146
Extensions Manager, 146-147
Finder hiding, 145
help, 138-139
Launcher program, 147
Macintosh Drag and Drop,
143-145
Macintosh Easy Open, 148-
149
Macintosh Guide, 138-139
Macintosh PC Exchange,
148-149
MacTCP, 149
menubar clock, 147
overview, 136-138
PowerBooks, 150-152
PowerTalk, 154-155
productivity and
customization, 142-147
QuickDraw GX, 152-154
QuickTime, 157
speed boost, 147
Stickies, 146
support for large hard drives,
147
System Folder locking, 146
Telephone Manager, 155-156
Universal Enabler, 147
WindowShade, 146
New Folder command, 57

New Group command, 215
new hard disk drivers, 377
New Item Watcher script, 315
New User command, 215
NewGen TurboPS/400p, 183
Norton Utilities for the
Macintosh, 32, 377
Note Pad, 101-102
Filew>Go to Note command,
102
Find command, 102
fonts, 102
pasting text into, 103
text in and out, 102
Now Utilities, 326, 369, 385
numbers, formatting, 297
Numbers control panel, 297,
333
numeric keypad, controlling
cursor, 281-282, 359-361

e()e

on-line services, getting viruses
from, 24
Open command, 58§
Open dialog box, 115, 128-132
active folder, 287
disk name, 120
selectively displaying items,
132

Show Preview check box, 130
weird folder names in,
131-132
operating system, 10
Option key
closing all windows, 39
Special'’Empty Trash
command, 32, 59
viewing all subfolders, 76
08/2, compatibility, 148

ePe

Page Setup command, 65, 184
Page Setup dialog box, 65,184—
191

dogcow, 189, 191

GX-style, 184, 185

old-style, 184

options, 188-191

page flipping option,189-190

page inverting option, 190

page orientation option,
186-188
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paper type options, 185-186
precision bitmap alignment
option, 191
reduce or enlarge/scale
option, 188
pages, setting up for printing,
184-191
Paper Type Editor, 367
parent file, 62
passwords, changing, 229
Paste command, 70
path, Save dialog box, 121
path menu, 117
PC Exchange control panel,
298-299, 333
PDD (portable digital docu-
ment) format, 207-208
PDD Maker GX extension, 345
Peirce Print Tools extension,
185
PhoneNet connectors, 211
PICT files, previewing, 130
pixel depth, 257
pixels, 96, 254
PlainTalk, 364-365
pointer
hot spot, 31
pop-up menus, 53
portrait orientation, 186
PostScript files
including all fonts, 196
printing to, 195-200
reasons to create, 197
Power Macintosh
Graphing Calculator, 96
Modern Memory Manager,
244-245
PowerBook control panel,
299-300
PowerBook Setup control
panel, 301-302
PowerBooks, 150-152
adjusting monitor brightness,
273-274
AutoRemounter control
panel, 272-273
computing, 150-152
Control Strip, 150
Control Strip control panel,
277-278
convenience features, 152
File Synchronization, 151
internal or external modem,
301-302
SCSIID number for hard disk,
301-302
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setting performance, 299-
300
shared disks, 272-273
synchronizing folders with
another Macintosh, 316
utilities and enhancements,
150-152
PowerTalk, 81, 154-156, 302,
365-366
AppleMail, 155
authentication and privacy,
155
Catalog icons, 32
digital signatures, 155
directories, 155
information about, 86
installing, 365-366
Key Chain, 101, 155
Mail & Catalogs folder,107-
108
messaging between applica-
tions, 155
support for mail-capable
applications, 155
Tray icon, 32
universal mailbox, 1565
PowerTalk Data (folder), 351
PowerTalk extension, 342
PowerTalk Guide command, 86
PowerTalk Manager extension,
342
PowerTalk messaging between
applications, 155
PowerTalk Setup control panel,
302, 333
PPP (Point to Point Protocol),
356
PRAM (parameter RAM)
zapping, 378
Preferences dialog box,
Confirm Window-Closing
option, 105
preferences files, 351-352
backing up, 352
fixing program problems,
352

Preferences folder, 351-352
Previous System Folder, 388
Print command, 58, 66
Print Desktop command, 66
Print dialog box, 66, 191-201
alerts for starting and
ending, 198
cover page, 194-195
Desktop Printers, 205

Destination: printer or
PostScript file, 195-196
GX-style, 193
number of copies, 193
old-style, 193
pages to print, 194
Paper Match option,199-200
paper source/feed, 195
Print quality, 196-198
Print time, 198
Print Time icon, 198
StyleWriter, 200-201
Print Setup command, 184
Print Time icon, 198
Print Tools extension, 205
Print Window command, 66
Printer Descriptions folder,
346
printer drivers, 181
Printer Drivers extension, 345
Printer Share extension, 343
printers
AppleTalk, 182
choosing, 180-184
connecting, 180
connection guidelines, 181
Easy Install option, 181
NewGen TurboPS/400p, 183
paper source/feed, 195
paper trays, 204
printing to, 195-196
QuickDraw GX-savvy driver,
181
reading manual, 179
represented as icon on
Desktop, 201-202
SCSI or server-based, 182-183
selecting, 97
serial, 182
PrinterShare GX extension,
343
printing, 58, 179-208
active window picture, 66
additional formatting control,
199-200
alerts for starting and ending,
198
AppleTalk active/inactive,
183-184
background, 200
bitmapped pictures clearly,
191
cover page, 194-195
deferring till specific time, 204
Desktop picture, 66

Desktop Printers, 184, 201~
205
documents, 66
dragging document onto
Desktop Printer,
201-202
flipping pages, 189-190
inverting pages, 190
landscape orientation, 186
number of copies, 193
page orientation, 65,186-188
pages larger or smaller, 188
pages to print, 194
paper type, 185-186
pausing, 204
portrait orientation, 186
print quality, 196-198
resuming on-hold file printing,
204
scaling, 65
selecting extensions, 205
setting time to print, 198
setting up pages, 184-191
starting, 204
stopping selected files from,
204
to PostScript file, 195-200
to printer, 195-200
type of paper, 65
viewing print queue, 203
Printing menu, 203-204
Printing=>PDD Maker Setup
command, 207
PrintMonitor, 346
productivity, 142-147
Program Linking turning on,
214-215
programs, 137-138
After Dark, 326
Anti-Virus, 24
Apple Backup, 23
Apple HD SC Setup, 17, 377
AppleScript-enabled, 316-
317
Applications folder, 166
AutoDoubler, 323
Conflict Catcher, 147
Conflict Catcher II, 283
consistency, 192
custom print/Page Setup
dialog box, 180
Disinfectant, 24
Disk First Aid, 17, 376-377
DiskFit Direct, 23
DiskFit Pro, 23
Eudora, 355



forcing them to quit, 82
giving them less memory,
91-92
how much memory they use,
90
INITPicker, 283
LaserWriter Utility, 197, 367
linking, 210, 214-215
listing used, 86-87
MacTools, 32, 377
Mavis Beacon Teaches
Typing, 252
Maxima, 248
Mosaic, 355
Norton Utilities for the
Macintosh, 32, 377
Now Utilities, 326
opening files from another
program, 169-178
Page Setup command, 184
Paper Type Editor, 367
PPP (Point to Point Proto-
col), 356
Preferred Memory Size, 91-92
Print dialog box, 191
PrintMonitor, 316
program linking, 214-215
QuicKeys, 140, 142, 326
quitting, 129
RAM Doubler, 241, 244, 323
Redux Deluxe, 23
Retrospect, 23
running and hidden, 129
running multiple, 232
SAM (Symantec Anti-Virus for
Macintosh), 24
selecting from Apple menu,
111
SLIP (Serial Line Internet
Protocol), 356
Stacker, 323
Startup Manager, 282
switching between, 86-87
TurboGopher, 355
Type 1 Enabler, 368
Virex, 24
vs. desk accessories (DA),
350
windows in, 40
proportional fonts, 252
protocols, 212
Put Away command, 62-63

e () e
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Quadra Monitors extension,
343
QuickDraw GX, 152-154, 366-
368
fonts, 101
installing, 197, 366-367
new paper descriptions, 367
QuickDraw GX extension, 344
QuickDraw GX Installer, 197
QuicKeys, 140, 142, 326, 369
QuickTime, 137, 157
QuickTime extension, 344

ok e

radio buttons, 54
RAM (Random Access
Memory), 231-237
adding more, 232
application memory,
235-236
freeing up for applications,
235
reclaiming space, 324
running multiple programs,
232
SIMMs (Single Inline Memory
Module), 232
System software memory,
233-235, 239
viewing used, 233
what uses it up, 233
RAM disk, 245-248
RAM Doubler, 241, 244, 323
Read Me file, 18
read-only bulletin boards, 222
recalcitrant file, 384-386
Recent Applications folder, 108
recent documents, how many
to track, 269-271
Recent Documents folder, 108
Recent Servers folder, 108
recordable programs, 317
Redux Deluxe, 23
registered user, 220
remote devices, 210
Reset switch, 82
resources, installing, 387
Restart command, 81-82
restarting without extensions/
control panels, 381

7
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Resume on Page One com-
mand, 204

Retrospect, 23

root level, 162-163

rules of good typography, 254

eSe

sad Mac chimes, 372
sad Mac icon, 15, 372
SAM (Symantec Anti-Virus for
Macintosh), 24
Save As command, 126-129,
320
Save command, 320
Save dialog box, 115, 195
active folder, 287
active item, 119
buttons, 123-128
Cancel button, 124
deselecting folders, 125-128
Desktop button, 118, 123,
168
disk name, 120
drop-down menu, 120
Eject button, 123
file list box, 119-123
file name field, 121-123
navigating through folders,
119
New Folder button, 124
Open/Save button, 124-128
operation, 119
path, 121
Save button, 121
Save file dialog box, 118-126
Scrapbook, 102-103
screen, 255
easier to read, 276
enlarging, 362
icon size and updates, 259
updates, 254, 258-259
scri file, 233
Script Editor, 311-312, 318
scriptable programs, 317
Scripting Additions folder,
311, 346
scripts, 109, 140-142, 309-310,
312-321
scroll arrow, 36
scroll bars, 35
accent color, 277
scroll box, 35
SCSI (Small Computer System
Interface), 13
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SCSI Manager 4.3 extension,
344
SCSI or server-based printers,
182-183
SCSI problems, 378-380
block terminators, 379
cables, 380
Digital Active Termination,
379
pass through connectors,
379
termination, 378-380
terminator, 379
unique SCSI ID numbers, 380
SCSI termination, 378-380
Select All command, 71
serial printers, 182
servers
how many to track, 269-271
tracking last used, 108
Set Default Printer command,
204
Set Print Time command, 204
Share a Drop Folder script, 315
Sharing command, 61
Sharing Setup control panel,
213-215, 229, 302, 333
Shift key
disabling control panels and
extensions, 327
selecting multiple icons, 50
turning off extensions/control
panels, 233, 237, 381
Shortcuts command, 86
Shortcuts extension, 344
Show All command, 87
Show Balloons command,
83-84
Show Clipboard command,
69-70
Shut Down, 105
warning, 286
Shut Down command, 82
shutting Macintosh down, 11
SIMMs (Single Inline Memory
Module), 232
SimpleText, saving documents,
118-126
size box, 35
Skia, 101
SLIP (Serial Line Internet
Protocol), 356
Slow Keys, 360

SneakerNet, 209
Sound control panel, 303-304,
316, 334
Sound Off script, 316
sounds
automatically starting, 267
storing, 102-103
Special menu, 79-82
special symbols, viewing, 100
Special'Empty Trash com-
mand, 31-32, 59, 246
SpecialeErase Disk command,
246
SpecialeRestart command,
381
Special>Shut Down com-
mand, 11, 227
Stacker, 323
Start File Sharing script, 316
Start Print Queue command,
204
startup, 226, 267-268, 301
startup disk, 16-17
Startup Disk control panel,
304, 334
Startup Items folder, 267-268
Startup Manager, 282
startup process, 14-18
status line, 37
Stickies, 104-105, 146
Stickies feature, automatically
running, 267-268
Sticky Keys, 360
Stop File Sharing script, 316
Stop Print Queue command,
204
StyleWriter, Print dialog box,
200-201
subfolders, 46
Documents folder, 163
ideas for, 163
viewing all, 76
submenus, 105-109
turning on/off, 269-271
Sync Folders script, 316
System 7 Pro, 141
System 7.5
backing up before deleting
anything, 325
basics, 9-24
CD-ROM version, 20
Find File extension, 341

floppy disk version, 18-20
installing, 18-21
international versions, 305
loading by itself, 233
turning off features, 259
updating, 391-394
System 7.5 [nstaller
where AppleScript parts are
installed, 311-318
System 7.5 Update 2.0, 391-394
system extensions, 337-344
System file, 352
System Folder, 45, 162
Apple Menu Items folder, 349-
350
backing up before deleting
anything, 325
benefits of lean, 324
Clipboard, 350
ColorSync Profiles, 352
control panels, 328
copying from floppy disk, 50
extensions, 336-346
Finder, 350
folders with (disabled) after
their names, 328
locking, 146
MEQ Database, 351
opening, 110
other items in, 349-352
PowerTalk Data (folder), 351
Preferences folder, 351-352
storing stuff that doesn't
belong there, 165
System file, 352
what to keep/what to throw
away, 323-352
System software, 27, 90
clean System reinstallation,
386-389
clean vs regular installation,
387
definition of, 10
icons, 27
memory, 233-235
memory required, 90
reinstalling, 380
restoring deleted files,
325-326
ten optional pieces, 355-368
unable to find, 16-17
what it does, 10
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Tab key
moving among icons, 77
moving in Save dialog box,
122
selecting next icon, 36
tasks, step-by-step guidance,
84-86
TCP/IP (Transmission Control
Protocol/Internet Proto-
col), 149
Tekton, 101
telecommunications, 149
Telephone Manager, 155-156
temporary aliases, 168-169
ten optional pieces of System
software, 355-368
Close View, 362
Easy Access, 359-361
LaserWriter Utility, 367
MacTCP, 355-359
Paper Type Editor, 367
PlainTalk, 364-365
PowerTalk, 365-366
QuickDraw GX, 366-368
TolkenTalk, 361-362
Type 1 Enabler, 368
ten things to try when system
software goes bad. See
troubleshooting
Text control panel, 305, 334
text entry boxes, 55-56
time
formats, 279-280
Time Formats dialog box, 279
time-saving tips, 251-260
color, 254-259
keyboard shortcuts, 251
learning to type better,
252-253
monitor settings, 254-257

window color considerations,

257-258

title bars, 37

accent color, 277

Command-clicking, 117
Token Ring network, 361-362
TokenTalk, 212, 361-362
translators, 58
Trash, 30-32

emptying, 31, 81

inverting, 31
opening, 32
warning dialog box, 61
Tray icon, 32
troubleshooting, 371-389
TurboGopher, 355
Type 1 Enabler, 368
Type 1 fonts, converting
to QuickDraw
GX-compatible, 368
typing, 252-253
typography, rules of good, 254

ol e

Undo command, 68
Universal Enabler, 147
Unlock Key Chain command, 81
users, 215-217
assigning passwords, 217
everyone, 220
owner, 220
registered, 217, 220
removing, 218
Users & Groups control panel,
215-217, 305, 334

o/ e

video cards, 256
View by Date command, 73-74
View by lcon command, 71-72
View by Kind command, 73
View by Label command, 73
View by Name command, 72
View by Size command, 72
View by Small lcon command,
72
View menu, 71-77, 266
Viewrby Name command, 109
Viewrr by Size command, 110
Views control panel, 77,
306-307, 334
Calculate Folder Sizes option,
72
deactivating Calculate folder
sizes, 259
Geneva 9 font in Finder, 258
List Views section, 259
screen updates, 258-259
smaller icons, 259
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Virex, 24
Virtual Memory, 241-243
viruses, 23, 24

o (/e

Welcome to Macintosh
message, 14
Windows, compatibility, 148
windows, 33-40, 56, 146
color considerations, 257-258
highlight color, 277
selecting every icon, 71
WindowShade, 146
WindowShade control panel,
40, 146, 307-308, 335
WindowShade effect, 39-40
wires and connectors, 212
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zones, 213
zoom box, 34
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